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DOCUMENTATION
Technical and programming details on the MT830/MT831 meter can be found in:
 MT830-MT831_ENG V1,1.pdf: Technical description,
 MeterView 4: Users manual.

Note: MT83x meters comply with the current valid FNN instructions "Leitfaden zur Bewertung der Zuverlässigkeit und
Messbeständigkeit von Elektrizitätszählern und Zusatzeinrichtungen" from november 2011 and can be installed in
photovoltaic and cogeneration systems.

WARNING!
The meter installation must be performed by authorized persons, who are familiar with security against electric
current stroke. Feed-through terminals and auxiliary terminals are under voltage that can be lethal!
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1. Meter parts

Fig. 1: Meter parts

1. LCD display
2. Meter technical data
3. IR optical interface
4. Input/output module mark
5. Legend of displaying registers on LCD
6. Meter cover sealing screw
7. Terminal cover
8. Terminal cover sealing screw
9. Communication module mark
10. RESET key blocking element
11. RESET key
12. DISPLAY key
13. Impulse diode – active and reactive energy
14. Meter cover
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Meter and fixing dimensions comply with the DIN 43857 standard.

Fig. 2: Dimensions (MT831 meter) Fig. 3: Dimensions (MT830 meter)

A compact plastic casing is made of high quality self-extinguishable materials and is resistant to water and dust (IP53).

Meter terminals

MT830 meter

Voltage terminals Auxiliary terminals

Fig.4: Terminal block – direct connected meter MT830

Sensor for terminal cover opening

Voltage link

Additional voltage terminal
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Closed – opened voltage link:

Fig. 5: Voltage link – direct connected meter

There are  6 auxiliary terminals on the meter basic board. They could be defined as inputs (max. 2), outputs (max. 4),
communication (CS or RS-232 or RS-485) and external power supply.
To access terminal block remove terminal cover (8, Fig. 1: Meter parts), fixed with two screws (9). Seals from screws
must be removed.

Voltage and current terminals                   Auxiliary terminals

Fig. 6: Terminal block – indirect connected meter MT830

MT831 meter (with input/output and communication module)
There are  6 auxiliary terminals on the meter basic board. They could be defind as inputs (max. 2) and external power
supply. Additional inputs and outputs are located in the module.

Voltage link is opened

Voltage link is closed

Sensor for terminal cover opening

Additional voltage terminal
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Auxiliary terminals

Voltage and current terminals

Fig. 7: Terminal block – indirect connected meter MT831

Auxiliary terminals
Voltage and current terminals

Fig. 8: Terminal block – direct connected meter MT831

Input – Output modules
Regarding the module programming, two versions exists:

 “Factory preprogrammed” modules: terminal function is burned in the module memory, meter automatically
acccept the module setting, terminals are denotated according to the VDEW denotation, modules could be
reprogrammed only in the factory or with special factory tool – Module Programmator

 “Empty” modules: modules are programmed as empty, terminal function is defined by meter parameters – meter
defines the terminal function, terminals are denotated as T1, .. Tn for outputs and I1, In for inputs

When moudule is inserted into the meter, cursor IM must be ON. If it blinks, module is not programmed properly or it is
not programmed at all. Module must be sent back to the factory.

Sensor for terminal cover opening

Communication module

Communication module

Input-output module

Input-output module

Sensor for terminal cover opening

Additional voltage terminal

Additional voltage terminal



Page 8

MT830/MT831
Installation manual

MT860
Technical description

Connection diagram for modules is printed on the module itself and on the label, on the bottom side of the terminal cover.
Definition of input terminals – factory programmed input – output module (function is define in the module)

Fig. 9: Factory programmed input -output module

Terminal Terminal
designation Additional explanation

15 COM Common terminal for functional inputs
13, 33 TE1/2, TE3/4 Energy tariff input T1 – T4
14, 34 ME1/2, ME3/4 Demand tariff input M1 – M4
16 MPE External time/measurement period synchronization input
17 MZE External input for disabling of demand measurement
18 MREa Input a for external billing reset
19 MREb Input b for external billing reset
35 COM Common terminal
36 MKA Alarm output
37 MPA Measurement period output
38 ERA+A Energy flow direction +A
39 ERA+R Energy flow direction +R
40 COM Common terminal
41 +AA Pulse output +A
42 -AA Pulse output -A
43 +RA Pulse output +R
44 -RA Pulse output -R
45 RA1 Pulse output RA1
46 RA2 Pulse output RA2
47 RA3 Pulse output RA3
48 RA4 Pulse output RA4
65 COM Common terminal
61, 63 TA1/2, TA3/4 Demand tariff outputs T1 – T4
62, 64 MA1/2, MA3/4 Demand tariff outputs M1 – M4
67 MZA Output for disabled max. demand measurement
68 MRAa Output for external billing reset a
69 MRAb Output for external billing reset b
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Definition of input terminals – non-programmed input – output module (function is defined by the parameters in
the meter)

Fig. 10: Default »non-programmed«  input -output module

Terminal Additional explanation
C1, C2, C3 Common terminal for functional inputs or outputs
I1, I1, I3, I4 Input terminals
T1, …, T8 Output terminals

Function of input (output) terminal is written on the meter connection diagram (sticked on the bottom terminal cover side).
It could be also read out with the MeterView program:

Module designation
MIO-V12L51 1 x input, 4 x OPTOMOS outputs, 1 x OPTOMOS output
MIO-V42L81 4 x input, 4 x OPTOMOS outputs, 4 x OPTOMOS output
MIO-V12L41B11 1 x input, 4 x OPTOMOS outputs, 1 x bistable 5A relay  output

Definition of external power supply

Terminal Terminal
designation Additional explanation

30 50 – 240 V AC/DC External power supply
31 50 – 240 V AC/DC External power supply
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Communication modules
Regarding the module programming, two versions exists:

 “Factory preprogrammed” modules: communication parameters are burned in the module memory, meter
automatically acccept the module setting, modules could be reprogrammed only in the factory or with special
factory tool – Module Programmator

 “Empty” modules: modules are programmed as empty, communication parameters could be changed by meter
parameters

When moudule is inserted into the meter, cursor CM must be ON. If it blinks, module is not programmed properly or it is
not programmed at all. Module must be sent back to the factory.

Each module has two independend communication interfaces:
 primary
 secondary

“Passive” communication modules (modules without modem):

MK-2-3 RS-232 & RS-485
MK-3-3 RS-485 & RS-485
MK-1-3 CS & RS-485

Module designation Primary interface Secondary interface
MK-2-3 RS-232 RS-485
MK-3-3 RS-485 RS-485
MK-1-3 Curent loop RS-485

Primary and secondary communication interfaces are defined by the hardware in the module. Denotation expresess,
which interface is primary and which is secondary.

Communication module MK-2-3 (RS-232 & RS-485) :

Primary interface (RS-232) Secondary interface (RS-485)

Meter enables simultaneously reading via the both interfaces at the same time. Secondary communication interface is
shared with IR optical interface – when communication runs via optical probe, communication via interface in the module
is not possible.
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“Active” communication modules (modules with modem):

Module designation Primary interface Secondary interface
MK-f37 - 3 PSTN modem +CS+RS-485 RS-485
MK-f39 - 3 ISDN modem +CS+RS-485 RS-485
MK-f3a - 3 GSM/GPRS modem +CS+RS-485

– old version
RS-485

MK-f38a - 3 GSM/GPRS modem +CS+RS-485 RS-485
MK-3e - 3 Ethernet+RS-485 RS-485

Modules composed of primary interface (modem+CS+RS-485 – these two interfaces are intended for multidrop
communication) and secondary RS-485 interface.
Meter enables simultaneously reading via the both interfaces at the same time. Secondary communication interface is
shared with IR optical interface – when communication runs via optical probe, communication via interface in the module
is not possible.

Fig. 12: Communication module

Note: ISKRAEMECO suggest, that primary communication channel on multi-drop meter is used for cascading.

Fig. 13: Example of multidrop connectionwith MK-f38-3 communication module

RS-485 and CS interface intended for multi drop communication. If
CS is not used, it must be shortcuted!

Secondary RS-485 interface

FME antenna for GSM/GPRS
modem



Page 12

MT830/MT831
Installation manual

MT860
Technical descriptionFront plate

The following data is printed on the meter front plate:

 serial number,
 ownership number,
 type and version designation,
 accuracy,
 year of manufacturing,
 approval mark,
 rated voltage,
 rated and maximum currents,
 rated frequency,
 LED and output pulse constants,
 software version,
 owner’s name or logo,
 bar code,
 code of connection diagram and program number.
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Fig. 14: Front plate (MT831)
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Fig. 15: Front plate (MT830)

Power supply

Meter could be supplied from:

 multi-range internal power supply from main voltages,
 external power supply (50-230 V AC/DC) – on request
 “no power reading option” with SONDA 6 - on request
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Fig. 16: Optical-magnetic interface, Iskraemeco SONDA 6, connected to portable computer

“No power reading” – meter is powered via SONDA 6 optical interface. SONDA 6 could be connected to the portable
computer – in such case is possible to read meter manually via LCE or reading and programming (parameters and time
setting) with MeterView.
SONDA 6 could also be powered via soecial battery pack. In such case it is possible to read meter only manually via
LCD.

Fig. 17: Optical-magnetic interface, Iskraemeco SONDA 6, connected tospecial battery pack
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2. Installation
To install meter follow next steps:

1 - Adjust hook height to fit installation position of the meter. Sliding hanger enables installation for all fixing dimensions
from 165 to 230 mm.

Fig. 18: Adjustable hook at meter back

2 - Fasten the meter to the measuring spot by three screws.

Fig. 19: Screw positions

3 - Connect measuring, input and output circuits and communication cables in conformity with the connection diagram
stuck inside the terminal block cover on the meter and modules.

Connection diagram 3P4W for direct connected meter

Connection diagram for indirect connected meter (3P4W connection, connection via current and (or) voltage transformer)
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Connection diagram for indirect connected meter (3P3W connection – external Aaron, connection via current and voltage
transformer)

„k” current terminals are grounded „l” current  terminals are grounded

Connection diagram for indirect connected meter (3P3W connection, connection via current and voltage transformer)

Note: Such connection could be used only for maximal nominal voltage 3x100V … 3x230V and with implemented
vector registration only!
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4.  Connect inputs, outputs and communication interfaces.

5. Install the terminal block cover and fasten it by two screws. Seal the terminal block cover screws by wire and seal.

6. If reset key has to be locked, hang up the overhang and lock it up. The overhang hole diameter is 5 mm.

7. Power-up the meter. By connecting to the voltage the light emitting diodes illuminate. After 3s measuring data from the
auto-scroll sequence are cyclically shown on the display.

8. Select  GRID menu on the meter LCD and check phase voltages, currents, frequency and phase angles:

Menu “GRID”

32.7.0
Voltage - phase L1
226.3 V

52.7.0
Voltage - phase L2.
228.3 V

72.7.0
Voltage - phase L3.
229.7 V



Page 19

MT830/MT831
Installation manual

MT860
Technical description

31.7.0
Current - phase L1.
2.1 A

51.7.0
Current - phase L2.
3.9 A

71.7.0
Current - phase L3.
4.1 A

15.7.0

13.7.0 Three phsae instantaneous
power factor
0.9998

14.7.0 Frequency

Three phase instantaneous
active power (abs(QI+QIV)
+ (abs(QII+QIII))
2.0 kW

130.7.0 Three phase
instantaneous reactive
power (abs(QI+QIV) +
(abs(QII+QIII))

2.0 kW

131.7.0 Three phase
instantaneous apparent
power (abs(QI+QIV) +
(abs(QII+QIII))

2.0 kW

81.7.1 Phase angle between
voltage R and voltage S

81.7.2 Phase angle between
voltage R and voltage T
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3. Checking the meter

Voltages

The meter enables detection and alarming of the presence of phase voltages. Presence of voltage and phase sequence
is marked with L1L2L3 characters in the LCD.

 If all three symbols L1L2L3 are displayed, it means that all three phase voltages are present.
 If cursors L1L2L3 are blinking, phase sequence is not correct (because of natural connection, the reactive energy is

also properly measured).
 Any not displayed symbol (L1, L2 or L3) means certain phase voltage is not present ot lower than predifined value Un

– 90%
 When one phase voltage is over  or under the predefined limits, the AV status starts to blink. In such case check the

nominal - alarm voltage.

81.7.40 Phase angle between
voltage R and current R

81.7.51 Phase angle between
voltage S and current S

81.7.62 Phase angle between
voltage T and current T
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Load

If no load or lower than the meter sensitivity threshold is connected to the meter, the light emitting diodes illuminate
permanently, and the power flow direction symbols or quadrant respectively pulse.

If the load is higher than the meter sensitivity threshold, the light emitting diodes pulse with a frequency proportional to the
load and the power flow direction symbols and quadrant are shown on the display.

Factory pulse constants settings (values are programmable):
 Direct connected meter

o 3x230/400V, 5(60)A 1.000 imp/kWh
o 3x230/400V, 5(120)A 500 imp/kWh

 Transformer connected meter
o 3x57.7/100 …. 3x240/415V, 1(6)A 10.000 imp/kWh
o 3x57.7/100 …. 3x240/415V, 5(20)A 2.000 imp/kWh

4. Meter handling
LCD display on the MT83x meters can present different several of data - menu. It serves by two buttons: Data (black
key) and Reset (red key). Both keys are on the meter front. The reset key can be sealed separately from the meter cover,
or a padlock could lock it.

Fig. 20: Meter buttons

Keys, depending on the sequence they were pressed in and how long we kept them pressed, could execute various
actions. Such handling with the display, as well as the meter parameters programming is executed by one hand,
signifying that no simultaneous pressing of several control elements is required.

The following commands can be executed:

Black key (Data)

· Short press (tpressing < 2 s) - we select the next value in the list or the next chapter in the menu

· Long press (2 s  tpressing < 5 s) - activates the displayed chapter in the menu or it skips past months data
readout

· Extended press (tpressing  5 s) - interrupts data readout in the selected chapter, and returns back to the
AUTO display mode

Note: all specified time values are programmable!

Red key (Reset)

 Short press (tpressing < 2 s) - goes to next value (when time is setting with buttons), executes meter
billing reset (MD reset) - (meter must be in AUTO display mode)

 Long press (2 s  tpressing < 5 s) - factory SET mode

Pushbuttons perform next actions:

Activation time Scroll (black) Reset (red)
Short Move to next Next value,
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selection


Increase value,
Billing reset


Long Confirm
selection


Confirm setting,


Extended Meter returns

back to “Auto”
sequence


Factory SET
mode



Table 1:  Pushbutton actions

5. Display
LCD is designed according to the VDEW requirements.

Figure 21 - LCD

The measuring data on an LCD are displayed with eight 7-segment 8 mm x 4 mm high numbers. Displayed data are
identified with a five-digit OBIS identification codes (IEC 62056 – 61), 6 mm x 3 mm high numbers. Dimension of LCD
(visible area) is 69 mm x 20 mm.

Meter operates in different display modes

 Automatic data circulation Auto mode
Time between two register presentations on the LCD in “Auto” sequence is programmable. For registers identification
only 5 digits is used  9 register previous values could be presented on the LCD (in case, when all energies
(demands): A+, A-… S+, S- is presented on the LCD).
Some commands in the meter could be performed only in Auto mode:
 billing reset

Additional modes are accessible by the black and red button.
Displaying modes accessible by the black one:

 Manual data display – registers Std data mode
 Manual data display– Load Profile mode (P.01 and/or P.02 (programmable))
 Manual data display – network parameters (voltage, current, phase angle, ..) Grid mode
 Presentation of the GSM modem parameters  DiAg mode

Displaying modes accessible by the red button:
 Manual setting of time, date, … SET mode
 Registers presented in Auto mode with enhanced energy registers presentation TEST mode
 Resetting the LCD statuses of meter and terminal cover opening Intrusion restart mode

Format and data units  are programmed. Transformer connected meters, displayed values could be presented as primary,
semi-primary or secondary values (presentation of line voltage and current are secondary by default).
Besides measuring data, the energy flow direction, presence of phase voltages, display of individual events, meter
statuses and alarms can be displayed.

Status triangles

5 digits for code

8 digits for value

Voltage indicators

Units

Load character presentation
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Meters have back-light illumination for easy data reading at metering place with bad light condition. The LCD is
illuminated when any pushbutton is pressed. The illumination is switched-off after 3 minutes, if no pushbutton was
pressed at that time (illumination time is programmable).

Explanation of the statuses, presented on the LCD:

Fig. 22: Meter statuses presented on the LCD

Status ON:
T1 – T4 Tariff for energy
M1 – M4 Tariff for demand
IM Input/output module recognized correctly
CM Communication module recognized correctly
RV Reverse flow
COM Reading of the data via communication
SET Meter in SET mode
MCO Meter cover opening
TCO Terminal cover opening

Status BLINKING:
IM Input/output module is NOT recognized correctly (module is not programmed correctly)
CM Communication module is NOT recognized correctly (module is not programmed correctly)
AV Alarm voltage
FF Fatal error
SET Meter in TEST mode

Note: the meaning of each status is programmable and defined according to the customer wish!
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2.4.2 Power flow direction and quadrant indicator
The active energy flow direction graphic symbol and the reactive energy quadrant are displayed in the left upper angle.

Symbol Power flow direction and quadrant

 Active energy reception (A+)

 Active energy transmission (A-)

 Q1 Active energy reception (A+)

Reactive energy 1st quadrant (Q1)

 Q2 Active energy transmission (A-)

Reactive energy 2nd quadrant (Q2)

 Q3 Active energy reception (A+)

Reactive energy 3rd quadrant (Q3)

 Q4 Active energy transmission (A-)

Reactive energy 4th quadrant (Q4)

Q1, Q4 Two phases in Q1, one phase in Q4

The displayed symbol shows the active energy flow direction and the reactive energy quadrant. The pulsing symbols
show that the load is lower than the meter sensitivity threshold or the load does not exist at all. At the same time, the
meter calibration light emitting diodes illuminate without interruption.
Load character can be detected from the arrows indicator; exact values are possible to read from GRID menu.

Note: We don’t need any additional equipment to define is meter connected properly or not.

2.4.3 Phase voltages indicator
The phase voltages indicator shows whether each individual phase voltage is present or not.

L1 L2 L3

If all three symbols (L1, L2 and L3) are displayed, it means that all three phase voltages are present. Any not displayed
symbol (L1, L2 or L3) shows this phase voltage failure. If symbols L1 L2 L3 pulse, it means a wrong phase sequence. In
this case it is required to change the cables phase sequence. The phase sequence does not impact on measurement and
registration of the active and reactive energy.

Display is able to show data automatically or manually with using black button on the top of device. Changing between
different groups of data, shown on a display, is realised by pressing this button for short period. Groups, shown on display
are: Std data, P.01, Grid, Diag.

Phase L3 is not present

Wrong phase sequence
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Display test

We perform the display test to ascertain whether all segments of the display function. All segments are switched ON by

once pressing the black key (Data) in the AUTO display mode.

Fig. 23: LCD test activated by one pressing of black button in Auto mode

In the AUTO mode, the display is not illuminated in order to reduce power consumption of the meter. For illumination of
the display, press the black key (data) and keep it pressed for less than 2 seconds. The display will remain illuminated for
three minutes, unless in the meantime some other key is pressed.

6. Display handling
Display is able to show data automatically or manually with using black butto. Changing between different groups of data,
shown on a display, is realised by pressing this button for short period. Groups, shown on display are: Std data, P.01,
Grid, Diag.

· Short press (tpressing < 2 s)

· Long press (2 s  tpressing < 5 s)

· Extended press (tpressing  5 s)

Basic handling with the meter and data readout
Basic handlings with the meter and data readout are shown in the following diagrams of progress.

Black key pressed short or long

LCD test

Data readout on request
Reset key menu

Red key pressed short or long Black key pressed short or long

Data readout on request
Data key menu

Auto sequence of data readout
Data readout cycles

Figure 24: Diagram of data readout mode changing progress
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Data readout on request
Data key menu

    Readout on request
Std-dAtA

Black key pressed long

 Black key pressed short

Readout on request

Load profile

In menu displayed
Std dAtA

 Black key pressed short

 Black key pressed short

Black key pressed long

Message
     End
of list

In menu displayed
Grid

In menu displayed
P.01 P.01

        or (P.02)

 Black key pressed short

In menu displayed
Diag

 Programmable sequence for LCD!!

 Black key pressed short

Figure 25: Diagram of data lists selection progress in the Data key menu
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Figure 26: Diagram of data readout progress from the Standard data list

Data readout on request
Data list Std-dAtA

First data readout from
the list Std-dAtA

Displayed data/
History data

Further to the next
data skip history data

Black key press Short Black key press long

Further to the next
data or history
data
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Figure 27: Diagram of data readout progress from the Load-profile list

First date from
P.01

Black key pressed short

Record is
displayed

Black key pressed short

Next record

Go to next
record

Black key pressed long

Black key
pressed long

Black key pressed short

Last
record

Next date
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Reset key menu

Set mode SEt

Calibration mode tESt
(higher resolution displayed)

 Black key pressed long

Black key pressed short

Black key pressed short

 Black key pressed long

Black key pressed short

In the menu
displayed
    End

In the menu
displayed
    SEt

In the menu
displayed
    tESt

In the menu
displayed
 IntRUsion RSt

 Black key pressed long

Restart of “Intrusion
detection function”

Figure 28: Diagram of options selection progress in the Reset key menu
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Set mode SEt

Parameter, that
we wish to change

First numberpulses

Displayed je
value  with

pulsing number

Displayed the first parameter
from the list SEt

Shift forward
to the next
parameter

Pulsing number
is increased byčaza 1

Next
numberpulses

Last
number?

Yes

No

All numberspulse

Old value
kept

Value
to čkept?

No

Yes

New value
kept

Black key press.short or long
Red key pressed short or long

Black key press.short or long

Red key pressed short or long

Red key pressed short orlong

Black key press.short orlong

Figure 29: Diagram of parameters setting progress by keys in the Set mode
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Calibration mode tESt
(higher resolution displayed)

Next value from »Auto sequence« is presented

First value from
»Auto sequence« is
presented

Black button pressed short

Shift forward to the next value

Figure 30: Diagram of progress in the Test calibration mode

Menus on the display

6.1.1 Auto menu and Std dAtA display

When the meter is connected to the network voltage, LCD test appears on the LCD.

LCD test

After that, the readout shows data from the AUTO collection. Data to be displayed in the AUTO mode can be selected by
a customer when ordering meters and could be entered (reprogrammed) during the process of meter (parameter)
programming. Data are cyclically displayed on the screen in ten-second intervals (interval is programmable). In the AUTO
mode, the display is not illuminated.

Data readout on request
Data list Std-dAtA

First data readout from
the list Std-dAtA

Displayed data/
History data

Further to the next
data skip history data

Black key press Short Black key press long

Further to the next
data or history
data
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The list of data on request, Std-dAtA, contains registers defined by customer or standard factory setting. Data on request
from the Std-dAtA list appear on the display until the black key is pressed (long press) or until the time equal to
measurement period elapses. In order to allow the next value to appear, press the black key (data) again and keep it
pressed for less than 2 seconds. OBIS (or special) code of history data records has on its right side an additional one
(two)-digit number indicating the month for which the read out data is valid (1 - to the number indicating previous month, 2
- to the number indicating two months ago). In order to skip readout of history data records (measurement data for
previous months) keep the black key pressed longer than 2 and less than 5 seconds. If the black key (data) is not pressed
during the measurement period, the display returns to the AUTO mode.

Note: register list, presented for Auto and Std dAtA mode is programmable

Auto mode Std dAtA mode Register Explanation

Menu “Std dAtA”

Time
14:21:14
( hours, minutes, seconds)
Format: hh:mm:ss

Date
7th , November 2007
( year, month , day )
Format: yy-mm-dd or

dd-mm-yy

Reset numbers
12

Fatal error
( 00 , no error)

Device address
(38422315)0.0.0

F.F.0

0.9.1

0.9.2

0.1.0

1.8.0
Active energy import
(A+), total
33425.54 kWh
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1.8.2

Active energy import
(A+), tariff  T2
06816,69 kWh

1.8.1.1

Active energy import
(A+), tariff T1 - one
month  ago
12465,22 kWh

1.8.2.1

Active energy import
(A+), tariff T2 – one
months ago
09563,23 kWh

1.8.3
Active energy import
(A+),  tariff  T3.
04253.63 kWh

3.8.0

1.8.3.1

Active energy import
(A+), tariff T3 – one
months ago
06646.21 kWh

Reactive energy import
(R+), total
00567,92 kVArh

3.8.1
Reactive energy import
(R+),  tariff T1.
00246,15 kVArh

1.8.0.1

Active energy import
(A+), total – one months
ago
28674.66 kWh

1.8.1
Active energy import
(A+),  tariff T1
22355,22 kWh
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6.1.2 GRID menu

Menu “GRID”

3.8.2
Reactive energy import
(R+), tariff T2
00186,20 kVArh

3.8.3
Reactive energy import
(R+),   tariff T3
00567,92 kVArh

32.7.0
Voltage - phase L1
226.3 V

52.7.0
Voltage - phase L2.
228.3 V

72.7.0
Voltage - phase L3.
229.7 V

31.7.0
Current - phase L1.
2.1 A

51.7.0
Current - phase L2.
3.9 A

71.7.0
Current - phase L3.
4.1 A
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15.7.0

13.7.0 Three phsae instantaneous
power factor
0.9998

14.7.0 Frequency

Three phase instantaneous
active power (abs(QI+QIV)
+ (abs(QII+QIII))
2.0 kW

130.7.0 Three phase
instantaneous reactive
power (abs(QI+QIV) +
(abs(QII+QIII))

2.0 kW

131.7.0 Three phase
instantaneous apparent
power (abs(QI+QIV) +
(abs(QII+QIII))

2.0 kW

81.7.1 Phase angle between
voltage R and voltage S

81.7.2 Phase angle between
voltage R and voltage T

81.7.40 Phase angle between
voltage R and current R

81.7.51 Phase angle between
voltage S and current S

81.7.62 Phase angle between
voltage T and current T
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6.1.3 DIAG menu (for GSM modem only)

Menu “DIAG”

C.C.4 Operator code

C.C.5 Error code

7. Setup meter time  setup by pushbuttons
With the Reset (red key) and Data (black key) key we can change certain meter parameters, e.g. time, date, etc.
Remove the seal from the red key (Reset), i.e. unlock the overhang and pull pin to the left to release the key.
Press the black key LCD test appears on the display, than press the red key once.

The message showing that the meter will go in the SET mode.

If you want to use the keys to change the meter parameters, press the black key (Data) and hold it pressed it for more
than two but less than five seconds. The display will show the first data from the list of data you can set in the SET mode
(factory setting time and date). If you want to change the displayed data, press the red key (Reset) and hold it pressed
until the first character on the display starts pulsing. Otherwise, press the black key (Data) to display the next group of
data from the Set list.

0.9.1 Setting the time (format hh:mm).

In the first segment of the display, a number and a cursor will pulse. If you want to change the first value, press the black
key (Data). The pulsing value will be increased by one. Continue pressing the black key until you reach the desired value.
Press the red key (Reset) to enter the new value into the registers. At the same time, the cursor will move right to the next
segment.

The second value starts pulsing. If you want to change the second value, press the black key until you reach the desired
value and then confirm it with the red key (Reset). Otherwise, press the red key to move the cursor right to the next
segment. After the last value has been changed and the change has been confirmed with the red key, all numbers start
pulsing.

C.C.3 GSM signal level
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If you want to store the changed value in the register memory, press the red key (Reset). Otherwise, press the black key
to keep the old value. The display will now show the next group of data from the Set list.

After you have finished changing the parameters, push the pin to the right to block the red key and seal it, i.e. cover it with
the overhang and lock it and press the black button for more than 5 seconds to go out of the SET mode.

8. GSM/GPRS  communication module MK – f38a –3

Installation of the SIM card (SIM card must be enabled for data transfer)
1. Remove the GSM/GPRS modem from the meter

RS-485 and CS communication
interface, for multi drop – cascading
(CS must be shortcut)

Connector for FME
antenna

»Secondary« -
independent RS-485
interface

SIM card holder
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2. SIM card must be without PIN code (IP address must be known – related to the SIM card – not public)
3. Insert the SIM card into the SIM cardholder

4. Insert GSM/GPRS module back into the meter

5. Connect antenna into the modem

6. Write APN, username and password into the meter (via optical probe)

Move lock to the left,
to   enable opening
the SIM cardholder!
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7. For enabling multidrop communication via CS and RS-485 interface check the group CONSERETH settings.
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8. Check if module is logged in the GPRS network  Command prompt

Command telnet <IP address>

Command dis

Telnet commands:
Command Description
telnet <IP> Connection to the module
dis Parameter list
core Core version
fwident FW Version
hw HW version of Wavecom modem
modem Modem state
reset Activate 3 minutes postponed module reset
imei Modem’s IMEI number
upgcomm FW upgrade
quit Save settings and close Telnet connection
debug_i Send additional module information
set Parameter change (see parameter description)
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Parameter Description Command line
-tt Set Telnet gate number set –tt <tcp_port_num>
-tun Set Telnet Username (Max. length = 9) set –tun <username>
-tpw Set Telnet password (Max. length = 9) set –tpw <password>
dis Phonebook phonebook dis
add Add phone number into the phonebook phonebook add <phone#>

<restriction>
del Delete phonebook – selected  index phonebook del <index>
delall Delete all phonebook phonebook delall
gsr Set restrictions for the specified phone

numbers
phonebook gsr <restriction>

-apn Set APN

(max. length = 40)

set –apn <gprs_apn>

-gun Set user name

(max. length = 20)

set –gun <username>

-gpw Set password N

(max. length = 20)

set –gpw <password>

-tp Set TCP gate number set –tp <tcp_port_num>

-sp Activate serial port set –sp <serial_port_num>

-sb Baud rate set –sb <baud_rate>

-sd Data bits (7 or 8) set –sd <data_bits>

-ss Stop bit (0 or 1) set –ss <stop_bits>

-sr Parity (0-none, 1-even, 2-odd) set –sr <parity>

-sh Handshake (0-none, 1-RTS/CTS,

2-Xon/Xoff, 3-RTS toggle)

set –sh <handshake>

-cim Set IEC 62056-21 monitor status

(0-inactive, 1-active) – read only

-fip Set IP address for FTP server set –fip <ip_address>

-fun Set username for FTP access set –fun <username>

-fpw Set password for FTP access set –fpw <password>

-fpt Set file path on the FTP server set –fpt <file_path>
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-fnm Set file name on the FTP server Set –fnm <file_name>

9. Meter reading with MeterView

The basic procedure for using Meter View communications is as below. Each of the steps is explained in detail in the
following sections.

1. Set the communication parameters.

2. Set the correct password, if the operation requires a password.

3. Read or program the device.

If you wish to create a scheme (changing the parameters) , then the procedure is:

1. Select the device for which you want to create a scheme.

2. Define the parameters

3. Save to disk or write to device.

Reading the meter via optical probe in the meter

Set up the:
 Protocol IEC6256-21 (former IEC1107)
 Media Optical
 Port/modem  appropriate COM port in your computer
 Retries  1

With click to , select:
 Baud rate 300
 Data bits  7
 Parity even
 Stop bits 1

Device address is not obligatory.
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Reading the meter via RS-232 or RS-485 or current loop communication interface in the meter

Set up the:
 Protocol IEC6256-21 (former IEC1107)
 Media RS-232/Current loop
 Port/modem  appropriate COM port in your computer
 Retries  1

With click to , select:
 Baud rate 9600 (or select baud rate in the meter)
 Data bits  7
 Parity even
 Stop bits 1
 Device address it is on the meter front plate or read value in from the 0.0.0 register

o Obligatory for RS-485 and current loop interface (RS-485 and current loop interface in the MT83x meter
is defined as “multidrop” interface, reading the meter with “device address is obligatory)

o Not obligatory for RS-232 interface

Tip 1: How to check if Rx, Tx and GND terminals are connected properly? The voltage between Rx –GND and Tx-GND
must be around 9V.

Tip 2: When you connect meter to modem  connect Rx – Rx and Tx – Tx and when you connect meter to computer
connect Rx – Tx and Tx – Rx.
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Reading the meter via GSM or PSTN or ISDN modem in the meter – selection “Standard modem”

Set up the:
 Protocol IEC6256-21 (former IEC1107)
 Media Modem (standard)
 Port/modem  select appropriate modem, which is installed under windows system
 Retries  1

With click to , select:
 Baud rate 9600 (or select baud rate in the meter)
 Data bits  7
 Parity even
 Stop bits 1

All these data are related to the meter’s communication interface setting. Settings in the meter and in the modem
must be same.

 Device address it is on the meter front plate or read value in from the 0.0.0 register
o Obligatory – if more then one meter is connected to the GSM/PSTN/ISDN module

 Dial command write phone number
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Note: Computer modem settings and meter modem settings must be the same.
Note: Modem settings could be checked – changed under:

 Control panel ( ) Phone and Modem option ( )
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Note: Meter connected to ISDN modem can be read out only via ISDN modem!

Reading the meter via GSM or PSTN or ISDN modem in the meter – selection “Custom modem”

Set up the:
 Protocol IEC6256-21 (former IEC1107)
 Media Modem (custom)
 Port/modem  select COM port on the computer, where modem is connected
 Retries  1

With click to , select:
 Baud rate 9600 (or select baud rate in the meter)
 Data bits  7
 Parity even
 Stop bits 1

All these data are related to the meter’s communication interface setting. Settings in the meter and in the modem
must be same.

 Device address it is on the meter front plate or read value in from the 0.0.0 register
o Obligatory– if more then one meter is connected to the GSM/PSTN/ISDN module

 Init command write appropriate AT command to program your modem properly
 Dial command write phone number
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Reading the meter via Ethernet – transparent or consereth type

Transparent or consereth type is programmable.

9.6.1Setup the IP number in the Ethernet module – consereth type
Ethernet module parameters could be read out with Telenet server. Personal computer and module must be connected
with “crossover” LAN cable.

1. Set the computer IP address in the same subnet as the consereth module

Example:

Subnet mask, that should be
changed!
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Original computer subnet mask must be changed to

Connect the LAN cable (crossover) to module and computer and read/change parameters.
Default (factory) settings (could be read out via Telnet by utilising > telnet IP number > command:

> Username : user
> Password : ****   (user)

Username and password are by default settings the same »user«'.
Telnet server requests username (printed out), then also password (not printed out).
After setting the username and password, menu is listed out (lines 1 to 15).
Each parameter could be changed with command SET.

Example:

Set –tm 10.2.6.186 setting of IP module address

Set –tg 10.2.6.1 setting of gateway IP address

Set –pr 0 setting Consereth module type

9.1.1.1. Reset of module parameters to “ default”
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In case, that module parameters are lost and we don’t know the module parameters, it is possible to set up the original –
factory settings.

1. Dismantle the Ethernet PCB out of the module

1. Make a shortcut on the jumper J3
2. Insert the module for 10 seconds into the meter – module accepts the default (factory) settings.
3. Remove module from the meter
4. Remove jumper J3.
5. Put Ethernet PCB back to the module.

Reading the meter via Ethernet module – transparent type

Set up the:
 Protocol IEC 62056-21 (former 1107)
 Media Consereth (TCP-IP)
 Retries  1

With click to , select:
 IP address IP address, to which the module is connected
 Port Port programmed in the Ethernet module
 Type Transparent
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Note: Serial communication settings must be the same for the meter and the Ethernet modem.

 Device address it is on the meter front plate or read value in from the 0.0.0 register
o Obligatory – if more then one meter is connected to the Ethernet module

Reading the meter via Ethernet module - Consereth type:
Set up the:

 Protocol IEC 62056-21 (former IEC1107)
 Media Consereth (TCP-IP)
 Retries  1

With click to , select:
 IP address IP address, to which the module is connected
 Port Port programmed in the Ethernet module
 Type Consereth head

Note: Serial communication settings must be the same for the meter and the Ethernet modem.
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 Device address it is on the meter front plate or read value in from the 0.0.0 register
o Obligatory – if more then one meter is connected to the Ethernet module

Reading the meter via GPRS modem in the meter

Set up the:
 Protocol IEC 62056-21 (former IEC1107)
 Media Consereth (TCP-IP)
 Retries  1

With click to , select:
 IP address IP address, to which the module is connected
 Port Port programmed in the Ethernet module
 Type Consereth head

Note: Serial communication settings must be the same for the meter and the GPRS modem.

 Device address it is on the meter front plate or read value in from the 0.0.0 register
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o Obligatory – if more then one meter is connected to the Ethernet module

10. GPRS network connection setting in Windows XP system

In case that connection to GPRS network is via LAN interface, no additional setting is needed.

General Packet Radio Service (GPRS) is service that enables data transfer via mobile phone network (GSM). GPRS
enables service, that is known as "always on" data connection for GSM mobile phones. It enables faster WEB searching
and data transmission and also faster access to online services, like WAP and email. The major benefit  only
transmitted data are charged, connection time is not charged.
For connection into the GPRS network APN (Access Point Node), username and password must be known. These data
are published by mobile provider.

Instalation and modem settings:

Start Settings  Control Panel Printers and Other Hardware Phone and Modem Options
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Modems Add

Select: Don't detect my modem; I will select it from a list
Select: Standard 9600 bps Modem and select communication port, where modem is connected, for example:.: COM 1

Select installed modem, then press button Properties. In the window Advanced write:

at+cgdcont=1,"IP","iskraemeco.si"  where Iskraemeco.si is test APN

In window Diagnostic  Query Modem chech the modem response..

Check the modem settings, by pressing Change Default Preferences…
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Creation of GPRS connection on the computer:

Start Settings  Control Panel . Network Connections Create a new connection Connect to the internet Set
up my connection manually Connect using a dial-up modem select modem nominate the connection, for
example.: GPRS test connection phone number: *99***1#

Write: user name: XXXXX and password: remoteie
When connection is created, set up the preferences:
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Properties  Security  select Advanced (Custom settings) and press Settings  select only Unencrypted password
(PAP)

Under Networking select Internet Protocol (TCP/IP) and press Properties Advanced
 Switch off both options: Use default gateway on remote network and Use IP header compression

In Window Advanced must be Windows Firewall switched off or enabled with exception – only this connection.

When you make are new connection to GPRS network, is preferred to disable local area connection.
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11. Meter data reading with MeterViev

Data read out reading
Data read out meter sends data, w hich are defined for meter “Readout sequences”.
Reading coud be started on two different ways:

 By selecting command via Meter Read Registers (readout)

 By clicking icon

Data read out reading could not be protected with password.
Example of data read out:

Registers, which are presented by data read out are defined in “Read sequence”.
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Load profile reading
Load profile reading coud be started on two different ways:

 By selecting command via Meter Read Load profile

 By clicking icon

Load profile reading could be protected with password (protection is defined in the meter firmware and is requested by
custemer specification).



58

MT83x
Installation manual

Result:

Selecting of profile P.01,
P.02, which we want to
read

Specifying of start and
end time - date block,
which we want to readSelecting of block size (number of records), that

we want to read (profile period of 15 minutes,
creates 96 records per day). With reducing of
“block size”, automatically “R6” reading command
is used!
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Selects graphical mode for displaying the data.

Opens the graphing options. This button is only available when the data is
viewed in graphical mode.

Presentation of load profile in tabulated form

Presentation of load profile as raw data

These buttons are only available when viewing the data in graphical mode one
day at a time. The left arrow moves backward and the right arrow moves
forward one day at a time.

Presented as raw data:

P.01(0712010930)(00)(15)(6)
(1.5)(kW)(2.5)(kW)(5.5)(kvar)(6.5)(kvar)
(7.5)(kvar)(8.5)(kvar)
(0.1636)(0.0000)(0.1144)(0.0000)(0.0000)(0.0000)
(0.1520)(0.0000)(0.1104)(0.0000)(0.0000)(0.0000)
(0.1388)(0.0000)(0.1056)(0.0000)(0.0000)(0.0000)
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(0.1520)(0.0000)(0.1100)(0.0000)(0.0000)(0.0000)
(0.1552)(0.0000)(0.1108)(0.0000)(0.0000)(0.0000)
(0.1628)(0.0000)(0.1172)(0.0000)(0.0000)(0.0000)
(0.1548)(0.0000)(0.1128)(0.0000)(0.0000)(0.0000)
(0.1368)(0.0000)(0.1036)(0.0000)(0.0000)(0.0000)
(0.1536)(0.0000)(0.1108)(0.0000)(0.0000)(0.0000)
(0.1536)(0.0000)(0.1068)(0.0000)(0.0000)(0.0000)
(0.1468)(0.0000)(0.1080)(0.0000)(0.0000)(0.0000)
(0.1484)(0.0000)(0.1112)(0.0000)(0.0000)(0.0000)
(0.1424)(0.0000)(0.1024)(0.0000)(0.0000)(0.0000)
(0.1436)(0.0000)(0.1108)(0.0000)(0.0000)(0.0000)
(0.1472)(0.0000)(0.1124)(0.0000)(0.0000)(0.0000)
(0.1440)(0.0000)(0.1060)(0.0000)(0.0000)(0.0000)
(0.1356)(0.0000)(0.0976)(0.0000)(0.0000)(0.0000)
(0.1376)(0.0000)(0.1012)(0.0000)(0.0000)(0.0000)
(0.1340)(0.0000)(0.0980)(0.0000)(0.0000)(0.0000)
(0.1272)(0.0000)(0.0924)(0.0000)(0.0000)(0.0000)
(0.1204)(0.0000)(0.0884)(0.0000)(0.0000)(0.0000)
(0.1176)(0.0000)(0.0880)(0.0000)(0.0000)(0.0000)
(0.1240)(0.0000)(0.0928)(0.0000)(0.0000)(0.0000)
(0.1472)(0.0000)(0.1080)(0.0000)(0.0000)(0.0000)
(0.1508)(0.0000)(0.1092)(0.0000)(0.0000)(0.0000)
(0.1536)(0.0000)(0.1124)(0.0000)(0.0000)(0.0000)
(0.1408)(0.0000)(0.0984)(0.0000)(0.0000)(0.0000)
(0.1404)(0.0000)(0.1048)(0.0000)(0.0000)(0.0000)
(0.1524)(0.0000)(0.1100)(0.0000)(0.0000)(0.0000)
(0.1576)(0.0000)(0.1148)(0.0000)(0.0000)(0.0000)
(0.1516)(0.0000)(0.1116)(0.0000)(0.0000)(0.0000)
(0.1436)(0.0000)(0.1072)(0.0000)(0.0000)(0.0000)
(0.1508)(0.0000)(0.1104)(0.0000)(0.0000)(0.0000)
(0.1488)(0.0000)(0.1060)(0.0000)(0.0000)(0.0000)
(0.1476)(0.0000)(0.1068)(0.0000)(0.0000)(0.0000)

Presented as graph:
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Presented as »bar« graph:
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Log book reading
The log book is a list of events, each with a time stamp, that have occurred since the log book was last cleared. The
following events are logged.

Log book reading coud be started on two different ways:
 By selecting command via Meter Read Log book

 By clicking icon

Setting time and date with MeterView
11.3.1  With command W5
Time setting with W5 command is protected with W5 password.
Write password for W5 command:
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or write password direct in the window, prepared for time selection

11.3.2  With command W1
Time setting with W1 command is protected with password, for programming the meter.
Write password for W1 command:

Select »System (PC time)« or custom
time!

Write W5 password (it is automatically
copied from the »password« window!

In case, that »System« time was not
selected, select specific date & time,
also with option of “Summer” time
selection!
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Select

Note: Only “System” time could be selected!

Programming the meter MT83x
11.5.1 Entering the Password

MT83x meters have up to four different protections level (which password level is implemented in the meter, depends
on customer request):

 Password for reading the data (raeding of load profile data, log book data, registers reading, parameter reading)
 Password for programming the meter parameters
 Password W5 for time setting
 PARAM button (located under meter cover) – the highest protection
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Parameters in the meter could be protected with password for programming or PARAM button. If there is no
customer request for specific parameter protection level, factory set up is used. Protection for each parameter is
defined and burned in the meter firmware.

From the main window, select Meter ►Password►Enter Password.

or click on the icon .

The following window appears.

Meter View password-entry window.

Enter the passwords that will be used to access protected registers in the meter. This table summarises which
password is required for which operation.
Operation Required Password

Reading the registers No password required

Reading the load profile data No password required or password for reading or
password for programming (depends on customer
request)

Reading the log book No password required or password for reading or
password for programming (depends on customer
request)

Reading the SEP (Combined) data No password required or password for reading or
password for programming (depends on customer
request)

Writing a new scheme (parameters) Password for programming or PARAM button

Setting the time Password for programming or password W5 or
PARAM button

Reset of log book data Password for programming or PARAM button

Reset of load-profile data Password for programming or PARAM button
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Summary of password protection

11.5.2 Reading the Parameters
Check that no password is entered using the steps described in section Entering the Password.
To find how a meter is configured, from the Meter View main menu select Meter ►Read ►Parameters scheme.

The device parameters window appears, and the main window status bar indicates communications activity.
When the communications are complete, the following window appears.

Meter View's Device Parameters window

There are more parameters available than can be displayed on one window, so parameters are divided into pages
called “Groups”. You can select the group that you wish to view using the Group drop-down list on the toolbar.

Parameters for the specific program number (saved in the MeterView base – factory settigs)) could also be opened
directly from MeterView list:
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Select appropriate programme number and parameter window will automatically appear.

The functions of the other buttons on the toolbar are summarised in the following table.
Button Function

Parameters
selection
according
to the type
of meter

Parameters
selection
according
to the
Country/
Customer

Parameters
selection
according to the
type of meter

Parameters
selection
according to the
program number

Parameters
selection
according to the
Country/Customer



68

MT83x
Installation manual

Button Function

Saves the scheme to a file, thus creating a new scheme from existing parameters in a meter. You
are prompted to choose to save all the groups, just the currently displayed group or a free
selection of groups.
This button is the same a selecting File ► Save As.... As with most Windows applications, once
you've saved the work, you can use File ► Save to save to the same file.

Prints the scheme as a report. Just like save function, you can print all the groups, just the
currently displayed group or a free selection of groups.

Writes the currently selected parameters to any connected meter using the password selected in
the password window. (The Meter ► Password ► Enter Password option from the main menu is
still available when the parameters window is displayed.) You can use this function to copy the
scheme from one meter to another.
Note: Change ONLY parameters of one group at the same time!!!
Reads parameters from a connected meter into the current set. You can read all the groups, just
the currently displayed group or a free selection of groups.

Aborts a communications session in progress. Available only when communications are active.

Exports the data to a .ncs (this file is a list of IEC 62056 - 21 commands for use with another
Iskraemeco software product called MeterRead)or .cix file (this file is a list of IEC 62056 - 21
commands for use with another Iskraemeco software product called Meter View Light)

Creates or loads a parameter patch. A parameter patch is a small subset of one parameter page.
You can use this feature, for example, to export a frequently used tariff. This tariff can then be
imported into future schemes that you create thus saving you time.

Compares the current parameters with those from either a file or the default.

The lower part of the Device Parameters window is used to display information such as errors in entered values as you
changes the parameters.

11.5.3 Writting the Parameters

Parameters could be protected with two different levels:

 Password – low level

 PARAM button - high level (PARAM  button is located under meter cover)

Location of the PARAM button
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Procedure to change the parameters in the meter:

2. Set appropriate password (password or PARAM button)

3. Read the parameters in the meter or open parameters from the MeterView data base

4. Adopt the parameters according the request.

5. Set appropriate password (password or PARAM button)

6. Set up the communication settings in the MeterView

7. Write parameters

Note: Write only group of parameters that you want to change, not all of them!

Answers from the meter:

 Done!  Parameter was changed successfully

 Access denied!  Protection level doesn’t open the parameter lock, wrong protection level or wrong password

 Failed!  Parameter doesn’t exist in the meter

12. MT83x meter parameters
Parameters in MT83x meter can be protected with three different levels:

 Password for reading

 Password for programming

 PARAM button (located under meter cover)

12.1 Open the existing parameters from the Meter View
Parameters in the Meter View data base are set up by the meter type, customer (or country) and can differ from the
parameters that are stored in the meter. For viewing the parameters stored in a meter, we recommend the reading the
parameters. See capture “11.5.2 Reading the Parameters”.

To create a new scheme for the MT83x meter, from Meter View's main menu select File ► New Parameters scheme...

Alternatively, you can click , the leftmost button on the main window toolbar.
The following window will appear.
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List of MT83x devices supported by Meter View

Scroll down the extensive list to find the entry that represents the entry for your meter; perhaps the highlighted entry in
the above screen-shot.
Tip: If you're not sure of your meter's exact model code, but you have an example meter available, try reading its
parameters. The exact model code is displayed at the top of the parameters window.

Click when you have selected the meter you wish to configure.

Note: Parameters that are available in Meter View can differ from one version of Meter View to another, according to
customer requests. In this manual, only the most common parameters are described.
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Parameters are divided into Groups:

Note: parameters presented contained in the meter, could be different as presented bellow. They are dependent on the
functions, which are implemented in the meter and also reading protection level (on customer request, some
parameters are not visible).

12.2.2 Group Device information
Group Device information contains identification numbers of the meter. It is divided into Device identifiers and electricity
identifiers

12.2.2.1 Device information Device

Device identifiers are related to the factory specific identifications.
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ID: device (0.0.96.1.255) contains complete device identifications
ID : program_version (1.0.0.2.0) meter program version
Identifier #1 (0.0.96.1.0) factory number
Identifier #2 (0.0.96.1.1) meter identification
Identifier #3 (0.0.96.1.2) software package, related to the ISKRAEMECO production data base
Identifier #4 (0.0.96.1.3) date of creaition of the firmware
Identifier #5 (0.0.96.1.4) production year
Identifier #6 (0.0.96.1.5) reserved value
Identifier #7 (0.0.96.1.6) reserved value
Identifier #8 (0.0.96.1.7) reserved value
Identifier #9 (0.0.96.1.8) reserved value
Identifier #10 (0.0.96.1.9) meter’s calibration date

12.2.2.2 Device information Electricity

Device identifiers are related to the factory specific identifications. Parameters, except ID: electricity, are protected with
password.
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ID: electricity (1.0.0.0.255) contains complete electricity identifications
Identifier #1 (1.0.0.0.0) device address, register value is automatically copied into 0.0.128.4.7 register
Identifier #2 (1.0.0.0.1) reserved value for customer identification
Identifier #3 (1.0.0.0.2) reserved value for customer identification
Identifier #4 (1.0.0.0.3) production year
Identifier #5 (1.0.0.0.4) reserved value for customer identification
Identifier #6 (1.0.0.0.5) reserved value for customer identification
Identifier #7 (1.0.0.0.6) reserved value for customer identification
Identifier #8 (1.0.0.0.7) reserved value for customer identification
Identifier #9 (1.0.0.0.8) reserved value for customer identification
Identifier #10 (1.0.0.0.9) reserved value for customer identification

12.2.3 Group Display
Group Display consists of the parameters, which are related to the display parameters and register presentation, current
and voltage ratio,  ……

12.2.3.1 Display LCD settings
Group consists of the following parameters:
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Key down minimum [s] (0.0.128.0.1) minimum duration for activation of “short button press”
Key down long [s] (0.0.128.0.2) minimum duration for activation of “long button press”
Key down extra long [s] (0.0.128.0.3) minimum duration for activation of “extra long button press”
Display backlight on time [s] (0.0.128.0.5) definition of LCD backlight time
Sequence item timeout [s] (0.0.128.0.6) definition of sequence item time out – time for rolling the register in Auto
sequence mode
Console menu time out [s] (0.0.128.0.84) definition of console menu time out – in this time,  meter automatically
goes into Auto sequence
LCD flags (0.0.128.5.1) status meanings on the LCD (flag meaning is burned on the front plate)

NONE – status is not active
Status Status ON Status BLINKS
T1 … T8 tariff for energy -
M1 … M8 tariff for demand -
RCR1 .. RCR4
ERROR
COMM meter is in communication mode -
DST
INTERNAL TARIFF
IO MODULE MIO module is recognised by the

meter
MIO module is not recognised by the

meter (module is not programmed
properly)

COMM MODULE MK module is recognised by the
meter

MK module is not recognised by the
meter (module is not programmed

properly)
MAIN COVER Meter cover is opened -
TERMINAL COVER Terminal cover is opened -
FRAUD Fraud conditions exists on the meter -
DRO
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FF - Fatal error occurs on the meter
SET Meter in SET mode
TEST Meter in TEST mode
RTC Internal tariff is controlled by internal

meter clock
RS
MEAS IDLE
PHASE ORDER Voltage phase sequence is not OK
REVERSE FLOW Current in one phase is inverted
R IMPORT
S IMPORT
T IMPORT
CRITICAL ALARM
NON CRITICAL ALARM
BATTERY ALARM Internal Li battery should be replaced -
ALARM VOLTAGE - At least one phase missing or is

over/under specified limits
CURRENT WITHOUT VOLTAGE R Current without voltage state on

phase R
CURRENT WITHOUT VOLTAGE S Current without voltage state on

phase S
CURRENT WITHOUT VOLTAGE T Current without voltage state on

phase T

LCD date format (0.0.128.5.3) Definition of the date format, presented on the LCDYYMMDD or YYYYMMDD or
DDMMYY  and Date mark SPACE or UNDERSCORE (_) or HYPEN (-) mark.

YY or YYYY year presentation
MM month’s presentation
DD day presentation
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12.2.3.2 Display Formats, constants, units

Nominal current [A] (0.0.128.0.8)– definition of meter’s nominal current 5A or 1A
Transformer correction [ppm] (0.0.128.0.12)- transformer correction factor up to + 10000 ppm. It is used  also for
implementation of non- integer CT & VT values.
For example: VT ratio is 13800V / 110V = 125,4545454545
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Current fraud alarm limit [% of RMS] (0.0.128.0.71)– in case, that meter is eqquipped with neutral measurment
system
Formats and units table (0.0.128.3.1)– definition of formats and units for energy, demand, cumulative demand,
voltage, current, frequency, angle, power factor. Format for demand is adopted automatically regarding the maximum
current and nominal voltage. Related to these two values “rollover” time for energy registers is automatically
calculated (time needed, that meter register goes from 00000000 to 99999999) . In case, that “rollover time” is shorter
then 17500 hours (standard value), MeterView replies with note:

and rollover time is red coloured.

All other formats must be adopted manually.

Formats and units for presented data:

Digits Decimals Unit prefix Rollover

Energy number of digits (8) number of decimals (4) 7389 h

Example: 2345. 7653kWh
Rollover time: if meter is connected to voltage 58V and current is 6A, then meter register will go in 7398h from
0000.0000 kWh to 9999.9999 kWh and then back to 0000.0000 kWh. Rollover time is only informational value and
doesn’t affect to other parameters.

Max. Demand number of digits (5) number of decimals (4)

Example: 1.4564 kW

Cum. Demand number of digits (5) number of decimals (4)

Voltage number of digits (4) number of decimals (1)

Example: 058.3 V

Current number of digits (4) number of decimals (3)
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Example: 0.583 A

Frequency number of digits (3) number of decimals (1)

Example: 50.0 Hz

Angle number of digits (4) number of decimals (1)

Example: 120.0

Power factor number of digits (4) number of decimals (3)

Example: 0,833

Current ratio (0.0.128.0.11)- current transformer ratio. Example : CT ratio is inserted like 100/5, but value 20 is written
into and read out from the meter. When CT ration is written into the meter, meter automatically multiplies all energy and
register values with inserted CT ration. Current is presented as secondary value by default. Primary current presentation
must be done manually, by writing appropriate register.
Voltage ratio (0.0.128.0.10)– voltage transformer ratio. Example : VT ratio is inserted like 13800/100, but value 128 is
written into and read out from the meter. When VT ration is written into the meter, meter automatically multiplies all
energy and register values with inserted VT ration. Voltage is presented as secondary value by default.Primary voltage
presentation must be done manually, by writing appropriate register.
Nominal voltage (0.0.128.0.7)– nominal voltage on the measurement place, to which is meter connected, It is used
also as Alarm voltage, used for detecting over / under voltages.
Limit current (0.0.128.0.9) – current value, used only for calculation of “roll over” time for energy registers presentation

Note, which could appears:

Information, that you use excess demand function in the meter, should check the “Excess power limit”, because of
eventual change of CT and VT ratio.

Time
Date
Stamp

Baud rate
Device identifier

Current without voltage [mA] (0.0.128.0.119)  definition of the minimum current that flows through the meter and
voltage is not present (voltage is disconnected or voltage fuse is broken – fraud detection). Such condition is registered
in meter’s Log Book or presented via Alarm Output (MKA) – optional function in the meter

LCD time format (0.0.128.0.154) definition of time format presented on LCD HH MM SS or HH MM. Default value
HH MM SS.
HH – hour
MM – minute
SS - second

LCD date format (0.0.128.0.152)  definition of date format presented on LCD  YYYY MM DD or DD MM YYYY or
YY MM DD or DD MM YY. Default value YY MM DD.
YYYY or YY – year
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MM – month
DD - day

12.2.4 Common

LED constant [imp/kW(VAr)h) (0.0.128.0.13) LED constant, presented as imp/kWh/kvarh/kVAh. Default value for
multi range meter is 10.000 imp/kWh/kvarh/kVAh. LED constant could be presented also in LCD and parameter change

is written in Technical Log Book – optional function. Possible values:

LED source (0.0.128.0.14) definition of the energy sources, forward to the LED diode. Default value: left LED
active energy (all four quadrants), right LED reactive energy (all four quadrants).  Other combinations on request.

Billing reset (0.0.128.0.20)  enabling or disabling billing calendar (automatically billing reset)
 blockade of billing reset performed via the red button (console)
 blockade of billing reset performed via communication interface (comm)
 blockade of billing reset performed via billing reset inputs MRA and MRB (Input)

Values could be set from 1 minute to 65534 minutes. In case, that 65535 blockade is written into the meter, manual
billing reset is disabled.



80

MT83x
Installation manual

Active disp. Contract (0.0.128.0.21) definition of presented contract on the LCD (Contract 1 or contract 2). Default
value is Contract 1

Default profile type (1) (0.0.128.0.22) type of profile P.01

 No profile disabling of profile
 Cumulative energy (1.8, 2.8, ..) registers states are written in the profile
 Incremental energy (1.9, 2.9, .)  Increments of energy registered in the load profile period are written

into the profile
 current power (1.5, 2.5, ..)  Power registered in the load profile period is written into the profile

MP mode (0.0.128.0.118) measurement period mode definition :
 Synchronous MP + RTC synchronisation : block measurment period mode  and RTC

synchronisation via MPE input
 MP on input: measurement period is controlled via MPE input
 Asynchronous MP: sliding measurement period

Note: definition of block or sliding measurement period is related to the firmware configuration. If measurement period is
defined in the firmware as “Synchronous MP”, then is not possible to have in the same meter sliding period.
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13. Adding support for new meters

If meter Program Number is not supported in MeterView, the following window appears.

In this case, the meter producer will prepare DEVICE.INF, (the floppy disk with necessary files is normally added to the
delivered meters). If the files are in ZIP form, first unzip them to your choice of folder; for example C:\TEMP.

Example: supporting the 3100189v Program version in Meter View:
Select Settings ► Preferences ► Supported meters the Meter View main menu. The following window appears.

Select Add and the following window appears.
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Click  on the icon and  select folder, where you have copied the files:

Click :

Click green check mark OK:

And another green arrow:
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At the end you can check if the requested program number is supported in the Meter View.
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14. Installation of SONDA 5 USB driver
Before using SONDA 5 USB, driver must insalled to the computer. From the responsible Iskraemeco sales support, you
need to receive driver for SONDA 5 USB.
1. Copy this files to folder in your computer.

2. Connect SONDA 5 USB to appropriate port in your computer and follow the procedure.

Installation of USB serial converter:
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Select folder, where driver was
copied in step 1.
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Installation of USB serial port:
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Sonda 5 USB is ready for use. It is possible to check in the Windows system – serial port number:

Go to Control panel select System
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15. Technical data
Accuracy class
Active energy

Reactive energy

Apparent energy

A or B or C (EN 50470 - 3)

Class 2 or 1 (IEC 62053-21)
Class 0.5S (IEC 62053-22)

Classes 2, 3 (IEC 62053-23), calibrated up to 1%

Class 2 or 3, calibrated up to 1%
Voltages (V)
Voltage range

Reference frequency

3 x 57.7/100V ...  3 x 240/415V
3x100V … 3x415V (3P3W - external Aaron connection)
3x100V … 3x230V (3P3W connection)
0.8 - 1.15 Un

50 Hz ±5 % or 60Hz ±5 %
Currents (A)

Direct connection

Indirect connection

Start up current

Short-circuit

0.25 – 5(120)A,  (Class A or B)

0.01 – 1(6)A, (Class A or B or C)
0.01 – 1(10)A, (Class A or B or C)
0.05 – 5(6)A, (Class A or B or C)
0.01 – 5(10)A, (Class A or B or C)
0.05 – 5(20)A, (Class A or B or C)

0.002In for class A or B (EN 50470 - 3)
0.002In for class 2 or 1 (EN 62053 - 21)

0.001In for class C (EN 50470 - 3)
0.001In for class 0.5S (EN 62053 - 21)

30 Imax for direct connected
20 Imax for indirect connected

Outputs
Type

Contact

Permitted load

Pulse length

Transmission distance

PHOTO-MOS voltage-free relay

Make or break contact

25 VA (100 mA, 275 V AC)

From 20 ms to 240 ms (adjustable in steps by 20 ms)

Up to 1 km
Inputs
Voltage level

Current consumption

100 – 240 V AC
ON: U  80 V
OFF: U  20 V

< 2 mA @ 50V
< 10 mA @ 240V
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Self consumption of
current circuit

Self consumption of
voltage circuits

< 0,1 VA / phase

0.5 W / 1.1 VA (self consumption of voltage circuits, when meter is
supplied from the measuring voltages)

0.2 W / 0.4 VA (self consumption of voltage circuits, when meter is
supplied from the external voltage)

1.1 W / 3.7 VA (self consumption of the external power supply, when
meter is supplied from the external voltage)

max. 2.5 W / 3 VA (GSM module)
Communication
IR

CS

RS232

RS485

Protocols

Max. 9600 Baud IEC62056-21 (62056-21)

Max. 9600 Baud, passive, CL0 in compliance with DIN 66348, Part 1.

Max. 9600 Baud

Max. 9600 Baud

62056-21 mode C with or without a password.
LED output Impulse frequency  40 Hz

Impulse length approx. 8 ms
Real time clock
Accuracy

Back-up power supply

Crystal: 6 ppm =  3 min./year (at Top= +25C)

Super-Cap: 0.1F and  Li-battery
External power supply 50 - 240 V AC/DC
EMC
Electrostatic discharge

VF magnetic field

Transient test

Insulation strength

Impulse voltage

15 kV (IEC 60801-2)

10 V/m (IEC 60801-3)

4 kV (IEC 60801-4)

4 kVrms, 50 Hz, 1 min

6 kV, 1.2/50 s
Temperature ranges
Operation

Storing

-25C ... +70C

-40C ... +80C
Humidity > 95%
Terminals (diameter) CT connection: 5 mm (2 screws per terminal)

Direct connection: 9.5 mm (one screw per terminal)
Dimensions 327 x 177 x 90 mm
Mass Approx. 1.4 kg

Owing to periodical improvements of our products the supplied products can differ in some details from the data stated in the prospectus material.

Iskraemeco d.d., Energy Measurement and Management
4000 Kranj, Savska loka 4, Slovenia
Published by Iskraemeco. Data subject to alteration without notice.

UK Distributor for Iskraemeco:
SMS Metering Ltd.
Tel: + 44 (0) 845 604 7244 
E: info@smsmetering.co.uk 
W: www.smsmetering.co.uk




